The information described in this document is the exclusive intellectual property of Nuvoton Technology Corporation and shall not be reproduced without permission from Nuvoton.

Nuvoton is providing this document only for reference purposes of NuMicro microcontroller based system design. Nuvoton assumes no responsibility for errors or omissions. All data and specifications are subject to change without notice.

For additional information or questions, please contact: Nuvoton Technology Corporation.

www.nuvoton.com
Table of Contents

1 Overview .......................................................................................................................... 4
  1.1 Introduction .................................................................................................................. 4
  1.2 Features .......................................................................................................................... 4
  1.3 Supported Devices ......................................................................................................... 4

2 Installing Nu-Link Keil® Driver ......................................................................................... 5
  2.1 System Requirements .................................................................................................. 5
  2.2 Installation ....................................................................................................................... 5

3 Nu-Link Keil® Driver Configurations ............................................................................... 6
  3.1 Debug Form ..................................................................................................................... 6
  3.2 Flash Programming Form ............................................................................................... 8

4 Example – Create & Debug a Project ................................................................................. 10
  4.1 Create a New Project ..................................................................................................... 10
  4.2 Debug a Project .............................................................................................................. 15
    4.2.1 System Viewer ......................................................................................................... 18
    4.2.2 Breakpoints ............................................................................................................. 20
    4.2.3 PinView Plug-in ...................................................................................................... 21
    4.2.4 Semihosting ............................................................................................................ 21
    4.2.5 NuConsole Plug-in ................................................................................................. 22
    4.2.6 ITM/ETM Trace ....................................................................................................... 23

5 Firmware Update .............................................................................................................. 27

6 Nuvoton Announcement .................................................................................................... 28

7 Troubleshooting .................................................................................................................. 29
  7.1 ICE Disconnected When MCU Runs in XOM Region ..................................................... 29
  7.2 Breakpoint Limitation of XOM Region ........................................................................... 29

8 Revision History ................................................................................................................. 30
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-1</td>
<td>Supported Devices List File</td>
<td>4</td>
</tr>
<tr>
<td>3-1</td>
<td>Debug Setting Form</td>
<td>6</td>
</tr>
<tr>
<td>3-2</td>
<td>Flash Programming Setting Form</td>
<td>8</td>
</tr>
<tr>
<td>3-3</td>
<td>Chip Options Form</td>
<td>9</td>
</tr>
<tr>
<td>4-1</td>
<td>Select “NuMicro Cortex®-M Database”</td>
<td>10</td>
</tr>
<tr>
<td>4-2</td>
<td>Select Device in MDK4</td>
<td>10</td>
</tr>
<tr>
<td>4-3</td>
<td>Pack Installer in MDK5</td>
<td>11</td>
</tr>
<tr>
<td>4-4</td>
<td>Select Device from Software Pack in MDK5</td>
<td>11</td>
</tr>
<tr>
<td>4-5</td>
<td>Select System Viewer File</td>
<td>12</td>
</tr>
<tr>
<td>4-6</td>
<td>Select Thumb Mode</td>
<td>12</td>
</tr>
<tr>
<td>4-7</td>
<td>Select Debug Driver</td>
<td>13</td>
</tr>
<tr>
<td>4-8</td>
<td>Debug Setting Form</td>
<td>13</td>
</tr>
<tr>
<td>4-9</td>
<td>Select Flash Programming Driver</td>
<td>14</td>
</tr>
<tr>
<td>4-10</td>
<td>Flash Download Setting Form</td>
<td>14</td>
</tr>
<tr>
<td>4-11</td>
<td>Open Project</td>
<td>15</td>
</tr>
<tr>
<td>4-12</td>
<td>Build the Project</td>
<td>16</td>
</tr>
<tr>
<td>4-13</td>
<td>Download the Program</td>
<td>17</td>
</tr>
<tr>
<td>4-14</td>
<td>Debug Window</td>
<td>18</td>
</tr>
<tr>
<td>4-15</td>
<td>System Viewer Pane</td>
<td>19</td>
</tr>
<tr>
<td>4-16</td>
<td>Expand Register Group</td>
<td>19</td>
</tr>
<tr>
<td>4-17</td>
<td>Register Description</td>
<td>20</td>
</tr>
<tr>
<td>4-18</td>
<td>NuTool - PinView</td>
<td>21</td>
</tr>
<tr>
<td>4-19</td>
<td>Debug Information in UART Pane</td>
<td>22</td>
</tr>
<tr>
<td>4-20</td>
<td>Debug Information in NuConsole Dialog Box</td>
<td>23</td>
</tr>
<tr>
<td>4-21</td>
<td>Trace Setup with ETM</td>
<td>24</td>
</tr>
<tr>
<td>4-22</td>
<td>Initialize File for Trace Pins</td>
<td>24</td>
</tr>
<tr>
<td>4-23</td>
<td>Tracing Information Dialog</td>
<td>25</td>
</tr>
<tr>
<td>4-24</td>
<td>Trace Setup with ITM</td>
<td>25</td>
</tr>
<tr>
<td>4-25</td>
<td>Debug Viewer with ITM Data</td>
<td>26</td>
</tr>
<tr>
<td>5-1</td>
<td>Firmware Update Selection Dialog Box</td>
<td>27</td>
</tr>
<tr>
<td>5-2</td>
<td>Updating Firmware</td>
<td>27</td>
</tr>
<tr>
<td>5-3</td>
<td>Update Firmware Completely</td>
<td>27</td>
</tr>
<tr>
<td>6-1</td>
<td>Newer Version of Nuvoton Announcement</td>
<td>28</td>
</tr>
</tbody>
</table>
1 Overview

Nuvoton Nu-Link Keil® driver is a plug-in of Keil® µVision IDE used to debug Nuvoton chips via Nu-Link. For example, to start and stop program execution, set breakpoints, access memory and erase/program/verify Flash. This document introduces how to install and use Nuvoton Cortex®-M Keil® plug-in driver.

1.1 Features

The Nu-Link Keil® driver supports the following features. Some functions are triggered by µVision. The usages of these functions can be found in Keil® µVision User Guide.

- Erase/program/verify Nuvoton chips (via Flash algorithm of Nu-Link Keil® driver)
- Easy registers access of Nuvoton chips (via SVD files of Nu-Link Keil® driver)
- Support Hardware/Software/Flash breakpoint
- Support Data breakpoint
- Support various configurations for connection (Reset options, SWD clock, etc.)

1.2 Supported Devices

Open the hyperlink and you can see the table of supported devices: Link of Supported devices.

After installing Nuvoton Nu-Link Keil® driver, you can also check supported devices from µVision IDE main window “Help -> Open Books Window -> Supported devices of Nu-Link”, and SVD support status in “Supported SVDs of Nuvoton devices”.

![Figure 1-1 Supported Devices List File](image)

You can download the datasheet of each device from the following web pages:

http://www.nuvoton.com/hq/products/microcontrollers/arm-cortex-m0-mcus/DSheet/?__locale=zh_TW&resourcePage=Y (Cortex®-M0)

http://www.nuvoton.com/hq/products/microcontrollers/arm-cortex-m4-mcus/DSheet/?__locale=zh_TW&resourcePage=Y (Cortex®-M4)
2 Installing Nu-Link Keil® Driver

2.1 System Requirements

- **Software**: MDK-Arm® — V3.04 (or later)
- **Hardware**: Nu-Link ICE Bridge. (Keil® MDK PC software communicates with target chip via Nu-Link dongle)

2.2 Installation

To use Nu-Link Keil® driver, please follow the steps:

1. Install MDK-Arm® — V3.04 (or later) on your PC.
2. Run Nu-Link_Keil_Driver.exe file, and then select the <Keil® install path>. The following files can be found after successful installation of package:

- `<Keil® install path>\Arm\BIN\Nu_Link.dll`: Nu-Link Keil® driver’s DLL file.
- `<Keil® install path>\Arm\NULink\Nu_Link`: COPYRIGHT, License, Nu-Link announcement checker and so on.
- `<Keil® install path>\Arm\Flash`: Flash programming algorithm.
- `<Keil® install path>\Arm\SFD`: System viewer files.
- `<Keil® install path>\Arm\NULink\Nuvoton_NuMicro_CortexM_DataBase.cdb`: NuMicro® Cortex®-M MCU database, this file is only for MDK less than v5.0.
- `<Keil® install path>\Arm\HLP`: Help documents.

After installation, please make sure the Nu-Link Keil® driver version is consistent with the Nu-Link firmware version. If these versions are different, please do Nu-Link firmware upgrade (refer to chapter 5).

The latest Nu-Link Keil® driver is available on the following web page:
3 Nu-Link Keil® Driver Configurations

After selecting “NULink Debugger” as shown in Figure 4-7 and Figure 4-9, you can configure the Nu-Link Keil® driver. This chapter describes the “NULink Debugger” configurations.

3.1 Debug Form

Run µVision, select “Options for Target – Debug”, and then click the “Settings” button. The debug setting form is shown as follows.

- **Driver Version**
  Show the latest installed Nu-Link Keil® driver version.

- **ICE Version**
  Show the firmware version of the connected Nu-Link ICE.

- **Device Family**
  Show device family supported by the driver.

- **Device ID**
  Show ID CODE of SWD in a target chip.

- **Port**
  Currently, the Nu-Link Keil® driver only supports “SW”, which means SWD port.

- **Max Clock**
  Select the maximum SWD clock rate.

- **Chip Type**
  Select the target chip type. If user selects the wrong type, the download and debug procedure would be failed.

- **Connect options**
  Control the operations that are executed when the debugger connects to the target device.
  - **Normal**: Just stop the CPU at the currently executed instruction after connecting.
  - **under Reset**: Hold the hardware reset (HW RESET) signal active while connecting to the device.
● Reset options
Before getting into Debug mode, Keil® µVision IDE will issue a reset signal to target chip first, there are five reset options as described below:
- **Auto detect**: Use system reset first; if failed, use hardware reset.
- **HW RESET**: Use reset pin to reset target chip.
- **SYSRESETREQ**: Set system reset register of MCU.
- **VECTRESET**: Set vector reset register. (Cortex®-M0 does not support VECTRESET)
- **Not Reset**: Not to reset target chip when entering debug mode, which can keep the device status before connected.

● Verify Memory Code
Compare the content of the target memory with the application program loaded in the debugger.
3.2 Flash Programming Form

Run the Keil® µVision IDE, select “Options for Target – Utilities”, and click the “Settings” button. The Flash download form is shown as follows.

- **Flash Select**
  Select the target ROM to download, e.g. APROM or LDROM.

- **RAM for Algorithm**
  Select the Flash algorithm target address and size, programming algorithm will be copied to this address in programming process.

- **Download Function**
  Select active functions, all functions are listed below:
  - **Erase Full Chip**: erase all Flash data before programming Flash.
  - **Erase Sectors**: only erase Flash pages those are going to be programmed.
  - **Do Not Erase**: Not to erase Flash before programming it. (Not suggested)
  - **Program Flash**: Program Flash or not.
  - **Verify Flash**: Verify downloaded data or not.
  - **Reset and Run**: When download procedure is completed, IDE will reset target chip; then the target CPU will start to run.

- **Programming Algorithm**
  Display Flash algorithm that will be used in the “download” procedure. If user selects the correct chip type in Debug page, the correct Flash algorithm will be detected automatically.

- **Flash Breakpoint**
  “Enable Flash BP” will force Nu-Link Keil® driver to use Flash breakpoints. Otherwise, it will use hardware breakpoints or software breakpoints (When CPU runs on SRAM). Flash breakpoints and software breakpoints are unlimited. Refer to Arm® reference manual for the number of hardware breakpoints (e.g. Cortex®-M0 has 4, and Cortex®-M4 has 6).

- **Update Config0/1**
  Click the “Configure” button to open the “Chip Options” form. Config Bit can be modified in
the form when a field value is selected and the “OK” button is clicked. You can click the “Cancel” button to exit the form.

**Note:** In most NuMicro® chips, it will do “chip erase” before updating config0/1, but in M2351, only “NS address boundary modify” or “Flash unlock” will cause “chip erase”. Thus, users can download image first, and then set their configurations in M2351.

![Chip Options Form](image)

**Figure 3-3 Chip Options Form**
4 Example – Create & Debug a Project

In General use case, user can open project of Nuvoton BSP directly. There are two project formats — .uvproj for legacy MDK4 and .uvprojx for MDK5. If you want to create a new project and debug through the Nu-Link Keil® driver, follow the steps below (based on NUC140).

4.1 Create a New Project

1. Run the Keil® μVision4 IDE. Select “Project – New Project...” and the “Create New Project” dialog will appear. Input the new project name and click the “OK” button. Select “NuMicro Cortex-M Database” which is Nuvoton devices database, as shown below.

![Figure 4-1 Select “NuMicro Cortex-M Database”](image)

2. Select the microcontroller device that you have, as shown below.

![Figure 4-2 Select Device in MDK4](image)

User needs to install “Nuvoton.NuMicro_DFP.pack” before creating the project of .uvproj format for MDK5. Open `<Keil® install path>\UV4\PackInstaller.exe` as shown in Figure 4-3 and find “Nuvoton.NuMicro_DFP.pack” to install it. After installing the pack, the microcontroller device form is shown as Figure 4-4.
3. If user selects the correct device as shown in Figure 4-2, the RAM/ROM size and .SFR file will be filled up automatically. Otherwise, user has to set a correct RAM/ROM size and select correct .SFR file from "<Keil® install path>\Arm\SFD".
4. Enable the “Thumb Mode” option.

5. Select “Rebuild all target files” to build the project.
6. Select “Options for Target – Debug”. From the combo-box, select “Target ICE MCU” which is the USB Nu-Link Keil® driver. Make sure that the “Use:” radio box is checked, as shown below.

![Figure 4-7 Select Debug Driver](image)

7. Click the “Settings” button to open the debug setting form, and then select “NUC100” as the Chip Type.

![Figure 4-8 Debug Setting Form](image)
8. Select “Options for Target – Utilities”. From the combo-box, select “Target ICE MCU”. Make sure that the “Use Target Driver for Flash Programming:” check box is selected, as shown below.

![Figure 4-9 Select Flash Programming Driver](image)

9. Click the “Settings” button to open the Flash download setting form.

![Figure 4-10 Flash Download Setting Form](image)

**Note:** “Flash Select” can download project code to APROM or LDROM or others.
4.2 Debug a Project

This section describes how to debug a project by the Nu-Link Keil® driver (assuming that the installation and configuration steps had been performed).

Please follow the steps below:

- Run the Keil® μVision4 IDE. Select “Project – Open Project....” and the “Open Project” dialog pops up. Choose certain project as follows.

![Open Project](image)

Figure 4-11 Open Project
Select "Project - Build target" to build the project. The build window shown below should report no errors.

Figure 4-12 Build the Project
Click the "Flash - Download" icon to download the program into Flash.
Start to debug by selecting “Start/Stop Debug session”. When the hardware is properly configured, and the program successfully downloaded, the debugger window should look like Figure 4-14.

Figure 4-14 Debug Window

At this point the debugging process is similar as in μVision4 simulator. The program can be run, halted, run step by step, breakpoints can be set/cleared, and variables can be watched, memory areas read/written/modified.

4.2.1 System Viewer

In Debug mode, if user configures system-viewer as shown in Figure 4-5 correctly, the system viewer pane can be used by clicking “Peripheral” → “System viewer” in the menu bar, which can help developers to configure registers. The “System Viewer” is briefly described as follows.

Select a registers group such as “GCR”, and the registers group will be displayed in the right pane of IDE, as shown below.
To know detailed information of the registers group, you can expand it by clicking the “+” button as shown below.

To modify the value of register, users can edit the value field, and the detailed register description will be shown at the bottom:
4.2.2 Breakpoints

The Nu-Link Keil® driver supports “Execution Break” and “Access Break” of μVision IDE. You can check the μVision user guide for details: μVision User Guide → Debugging → Debug Windows and Dialogs → Breakpoints Window). Note that currently the Nu-Link does not support “Conditional Break” and “Count” in the breakpoint window.

“Execution Break” can be classified into three kinds of breakpoints: software/hardware/Flash. Each of the breakpoints is described below.

- **Software Breakpoints**
  When target application runs on target SRAM, Nu-Link Keil® driver will use software breakpoints, the number of breakpoints is unlimited.

- **Hardware Breakpoints**
  When target application runs on target FLASH, Nu-Link Keil® driver will use hardware breakpoints, these hardware breakpoints are provided by Arm® Cortex®-M core, the numbers are limited. (Cortex®-M0 has 4, Cortex®-M4 has 6)

- **Flash Breakpoints**
  When target application runs on target FLASH, and hardware breakpoints are all used, Nu-Link Keil® driver will use Flash breakpoints. (Note that “Enable Flash BP” in Figure 3-2 must be enabled)
  Flash breakpoints are unlimited, but using Flash breakpoint will make program execution much slower than using hardware breakpoints.

  “Access Break” is also known as data breakpoints.

- **Data Breakpoints**
  No matter target application runs on SRAM or Flash, users can set data breakpoints which are provided by Arm® Cortex®-M core. The number of data breakpoints are limited (e.g. Cortex®-M0 has 2, and Cortex®-M4 has 4).
4.2.3 PinView Plug-in

In Debug mode, user can select “NuTool – PinView” from “Debug” → “NuTool – PinView”, and then check the correctness of pin assignment through GUI.

![Figure 4-18 NuTool - PinView](image)

4.2.4 Semihosting

The Nu-Link supports some semihosting function for user to easily output and input message in Keil® IDE. To use the semihosting functions, please follow the steps below.

1. Open the “C:\Keil\Arm\BIN\Nu_Link\SemiHost\Src” directory and copy the following two files into your project folder:
   - SH_retarget.c
   - SH_startup_NUC1xx.s

2. Then open your project, and
   - Replace retarget.c with SH_retarget.c.
   - Replace startup_NUC1xx.s with SH_startup_NUC1xx.s.

3. Add printf/getchar in your source file where you need to debug.
   To reduce the code size, you can undefine the macros in SH_retarget.c to disable the real UART or semihosting UART1 or both.
   - #define DEBUG_ENABLE_UART
   - #define DEBUG_ENABLE_SEMIHOST
4. Build and run again.

5. In Debug mode, select “View → Serial Windows → UART #1” and click UART #1 to and open the UART #1 pane. The semihosting input/output will use this pane.

6. Now when you execute the program and run printf(“%s”, string), you can see debug information in the UART #1 pane as shown below.

![Figure 4-19 Debug Information in UART Pane](image)

4.2.5 NuConsole Plug-in

In addition to semihosting, the Nu-Link provides another I/O mechanism without affecting the target’s real time behavior. By using standard debug port SWD, it doesn’t need any additional pin or hardware. The only requirement is that the target application should reserve a buffer space (hereinafter referred to as InfoBlock) in SRAM in order to store control settings and communicate I/O data between NuConsole and target. To use the NuConsole functions, please follow the steps below:

1. Open the “C:\Keil®Arm\NULink\NuConsole_Sample” directory and copy the following files into your project folder:
   - NuConsole.h/c
   - NuConsole_Config.h
   - NuConsole_Retarget.c

2. Set up the project
   - Replace retarget.c with NuConsole_Retarget.c.
   - Add NuConsole.c to the project and include NuConsole.h in the corresponding files.

3. Configure InfoBlock
   - In NuConsole_Config.h, adjust the appropriate size of TX/RX buffers according to the application requirements and hardware limitation. Also, the TX buffer can be configured to be blocking or non-blocking. (optional)
   - Call NuConsole_Init() function to initialize InfoBlock before doing I/O operations (e.g. printf()).

4. Build the project
   - Build the code.
   - In the linker map “project_name.map” file under “project_path/lst” directory, find the value of symbol NuConsole_InfoBlock variable declared in NuConsole.c to get the memory address of InfoBlock. (Nu-Link Keil® driver will do this step, optional)

5. Download and run
6. In Debug mode, select “Debug → NuConsole” to invoke the control dialog. Set up the address of InfoBlock (Nu-Link Keil® driver will do the setting, optional), and then click the start button to process I/O data.

7. Now when you execute the program and run the I/O statements, you can see debug information in the NuConsole dialog as shown below.

![Figure 4-20 Debug Information in NuConsole Dialog Box]

4.2.6 **ITM/ETM Trace**

To start Embedded Trace Macrocell (ETM) tracing on Nuvoton Cortex®-M4/M23 devices, please connect to the device using the NuTrace with 20-pin connector and follow the steps below.

1. Configure the NuTrace.
   - In debug setting dialog, select the “Trace” tab.
   - In “Trace Port” select **Sync Trace Port with 4 bit data**. It is possible to use other bit sizes but best to use the largest to increase the bandwidth.
   - Select **Trace Enable** and **ETM Trace Enable**.
   - Click OK to save the changes.
2. In **Initialization File**, please insert the script file to initialize the device’s trace pins when starting the debugger. The following is an example script file.

![Initialization File for Trace Pins](image)

3. After doing above settings, user must start the debugger. In Debug mode, please select “Debug” → “NuTrace” to invoke the tracing information dialog, and it will show every single executed instruction in the current application as shown below.

![Trace Setup with ETM](image)
In the same way, user can also enable Instruction Trace Macrocell (ITM) as the following steps:

1. Select the **ITM Stimulus Port 0** in the trace setup dialog and save the changes.

2. In the development application, user needs to call the **"ITM_SendChar"** function which is defined in the CMSIS header file to trigger ITM events.

After the write to the ITM port 0, e.g. "ITM_SendChar('A')", the debugger will get the data out of the processor and display it in the Debug (printf) Viewer window as shown below.
Figure 4-25 Debug Viewer with ITM Data
5 Firmware Update

The Nu-Link firmware upgrade steps are described below.

1. Run Keil® µVision4 IDE, “Options for Target – Debug” and click “Settings” button or “Options for Target – Utilities” and click “Settings” button. If the current firmware version is not consistent with the installed Nu-Link Keil® driver, a dialog box will pop up informing the firmware update as follows.

   ![Figure 5-1 Firmware Update Selection Dialog Box](image)

   Figure 5-1 Firmware Update Selection Dialog Box

2. Click “Yes” to update firmware or click “No” to cancel.

   ![Figure 5-2 Updating Firmware](image)

   Figure 5-2 Updating Firmware

3. When update is complete, it is necessary to recreate a connection between Nu-Link and PC, and pop-up firmware update OK dialog as follows.

   ![Figure 5-3 Update Firmware Completely](image)

   Figure 5-3 Update Firmware Completely
6 Nuvoton Announcement

When the PC is online, the Nu-Link Keil® driver will check if there is any updated driver or announcement on Nuvoton website automatically. It will do the check when user runs Keil. Users may see the message below.

Figure 6-1 Newer Version of Nuvoton Announcement

The message above means there is a new version of Nu-Link Keil® driver updated on Nuvoton website. Click “Yes” to download the driver from Nuvoton website, and click “No” to close the dialog box.

Note that even users install the latest driver, this dialog may also pop-up for updated “Nuvoton News” below. If users don’t want to see this dialog box again, check the “Do not show this dialog again” option.
7 Troubleshooting

7.1 ICE Disconnected When MCU Runs in XOM Region
Some NuMicro® chips support XOM feature, and when MCU runs in XOM region, it won’t send any response to ICE. The ICE will be disconnected after timeout, the timeout interval is different from each ICE vendor.

7.2 Breakpoint Limitation of XOM Region
When user wants to set breakpoints after XOM region, the very first instruction after XOM region can’t be set. User must set the address one word away from the last instruction of XOM, or it won’t be stopped.
## 8 Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Revision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2010.02.05</td>
<td>1.00</td>
<td>First release for beta-site test.</td>
</tr>
<tr>
<td>2010.03.08</td>
<td>1.01</td>
<td>Added Config bit, Peripheral UI, semihosting.</td>
</tr>
<tr>
<td>2010.06.23</td>
<td>1.02</td>
<td>Modified Debug Setting Dialog and Peripheral.</td>
</tr>
<tr>
<td>2010.07.22</td>
<td>1.03</td>
<td>Added M50x series and N572.</td>
</tr>
<tr>
<td>2011.08.03</td>
<td>1.17</td>
<td>Added Nano100 series and Mini51 series.</td>
</tr>
<tr>
<td>2013.07.01</td>
<td>1.18</td>
<td>Added NUC200 series, NUC123, “Nuvoton Announcement”, and “Firmware Update” chapters.</td>
</tr>
<tr>
<td>2014.02.10</td>
<td>1.19</td>
<td>Changed document format, update “Support chips” and “Peripheral” chapters.</td>
</tr>
<tr>
<td>2014.10.24</td>
<td>1.20</td>
<td>Changed document and figure format.</td>
</tr>
<tr>
<td>2016.03.25</td>
<td>1.31</td>
<td>Updated “Nu-Link Keil® Driver Configurations” chapter.</td>
</tr>
<tr>
<td>2017.02.23</td>
<td>2.01</td>
<td>Added “NuConsole” chapter.</td>
</tr>
<tr>
<td>2017.10.13</td>
<td>2.03</td>
<td>Added XOM and M2351 notes.</td>
</tr>
<tr>
<td>2018.09.05</td>
<td>2.05</td>
<td>Added “ITM/ETM Trace” chapter.</td>
</tr>
<tr>
<td>2018.12.21</td>
<td>2.06</td>
<td>Changed document and figure format.</td>
</tr>
</tbody>
</table>
Important Notice

Nuvoton Products are neither intended nor warranted for usage in systems or equipment, any malfunction or failure of which may cause loss of human life, bodily injury or severe property damage. Such applications are deemed, “Insecure Usage”.

Insecure usage includes, but is not limited to: equipment for surgical implementation, atomic energy control instruments, airplane or spaceship instruments, the control or operation of dynamic, brake or safety systems designed for vehicular use, traffic signal instruments, all types of safety devices, and other applications intended to support or sustain life.

All Insecure Usage shall be made at customer’s risk, and in the event that third parties lay claims to Nuvoton as a result of customer’s Insecure Usage, customer shall indemnify the damages and liabilities thus incurred by Nuvoton.